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What you will find in this document: 

 
The purpose of this document is to provide a brief review of the FireSoft

®
 

software application.  This review includes an overview of general usage, 

creation of a new customer including addition of and management of the 

customers departments, and the addition of installation jobs and service 

management. 

 

Only a couple reporting mechanisms are contained within this document.  

Your company will have custom reports that meet your personal needs.  

Currently some custom reports may not display any data in the Demo 

Application due to the reliance on SQL Server Reporting that is not an 

available feature when utilizing the Microsoft SQL Server
®
 Desktop Engine 

(MSDE). 

 

This document is intended to be read from start to finish. Some information 

regarding customers may be found in the installations or service 

management sections that are not contained in the customer section of the 

document.   

 

The contents listing is solely for convenience and should only be used as a 

reference once the document has been read thoroughly. 

 

 

 

General information and introduction to application use………......... Pg. 3 

Information regarding customers in the system………....................... Pg. 14 

Information regarding installations in the system…………………… Pg. 33 

Information regarding service management in the system………….. Pg. 48 

Miscellaneous management features in the system…………………. Pg. 64 
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The initial application entry point is the logon screen, where a user of the 

system provides a username and password to access the application. 
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After successfully logging in to the application, the search form is presented 

to the user. 
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By default, the customer look-up tab is selected, where search criteria can be 

specified to locate customers in the system. 

 

 
 

In this screenshot, we searched for customers with an ‘Active’ status in the 

system, which had the Hood Systems department serviced by our company. 
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By double-clicking on the customer, the customer information card is 

presented which contains details on the customer. 

 

 
 

You will also notice that by default a ‘Notes Log’ selection form is 

displayed.  Any notes regarding the customer added by a department for 

public viewing will display here. 
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The configuration options allow the user to customize preferences such as 

whether or not to display this notes log selection when a customer is first 

opened. 
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As you can see here, there are several customizable options that are stored 

uniquely for each user of the system. 
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By clicking on a department tab (Hood Systems in our case) from within the 

customer card, information specific to that department’s services and system 

details are displayed. 

 

 



FireSoft Reviewer’s Guide Page 10 of 72 February 12, 2008 

 

© Copyright 2006-08 by FireSoft Solutions, LLC. 
All Rights Reserved. 

By clicking on ‘Notes Log’, the notes specific to the department are 

displayed. 
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You’ll notice that Hood System department notes exist for this customer, 

although they weren’t displayed when the customer was first opened.  This 

is because the note was set to ‘hidden’ so only the department making the 

note sees it visible. 
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Also from the Department tab, double clicking on a service in the services 

list opens the ‘Service Card’ 

 

 
 

This particular service has already been marked as complete, so it cannot 

receive any further modifications. 
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A service opened that has not yet been completed will allow editing of all 

information. 
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Adding a new Customer 

 
From the File menu, you can select to add a new customer to the system. 
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You will be prompted to enter a name for the customer.  This is the only 

‘required’ field for the customer at the time of demo release 
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Once you have entered a name, you can edit address, phone number and 

other information.  Next you will likely want to add a department to this 

customer.  This is done from the Tasks menu. 
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You will be prompted to select a department from the list of available 

departments.  The departments listed in the demo may not be the 

departments in your company’s customized application. 
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Once the department is added, you will see the departments tab appear on 

the customer card, and information on this tab will be empty. 
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The first thing you may want to do is assign a service frequency to the 

customer, assuming the services performed are recurring and you know how 

often they need to be performed. 
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At this point you may want to add a specific system that you know the 

customer has, to record any information you have on the system.  This is 

done from the tasks menu. 
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Each department will have specific information you are able to record.  This 

information will be customized to fit your needs, and may not be the same as 

the information available for recording within the demo application. 
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Once you have completed entering the information, or if you have skipped 

this part, you may want to begin services for the customer.  This only has to 

be done once after you create a customer, or after a customer has been re-

activated from a prior de-activation. 
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You will be prompted to choose the date this customer departments next 

service is due.  If you don’t know at this time, you can still click OK because 

it can be overridden at any time. 
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A recurring service schedule has now been established in this department.  

You’ll see the first service due date appear in the services list. 
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Extra services can be performed outside the normal service schedule in a 

department by clicking on ‘Extra Services’.  Most of the time, extra services 

include emergency services or immediate service requests for whatever 

reason. 

 

When ‘Add Extra Service’ is chosen, you will be prompted to specify 

whether this is a scheduled service or not.  If the service is to be performed 

at a later date (it is being scheduled) you could choose to schedule the 

service by choosing ‘Yes’; if the service needs immediate attention, you may 

want to record the service without adding it to the schedule, in this case you 

would choose ‘No’. 
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We chose to schedule the service in this case.  After entering the date and 

time the service is to be scheduled, clicking ‘Add to Schedule’ prompts for 

verification. 
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When opening extra services again, we can see that this extra service has 

been scheduled outside of the normal service schedule, and it is not yet 

completed. 
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By clicking on the Customer Info tab, we also can see this service listed in 

the scheduled services section, along with information that it is an Extra 

Service. 
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Technicians can only be manipulated when the department tab for which the 

technicians exist is selected.  Once selected (Hood Systems tab is selected in 

this case) the Technicians can be manipulated from the tasks menu. 
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Choosing to edit technicians in the department provides a list of currently 

available technicians to select from.  From here, the technician is selected 

and any modifications can be made. 

 

 



FireSoft Reviewer’s Guide Page 31 of 72 February 12, 2008 

 

© Copyright 2006-08 by FireSoft Solutions, LLC. 
All Rights Reserved. 

Choosing to add a new technician in the department displays a blank 

technician information form. 
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Like any other record addition in the system, if the required information is 

not entered, you will be notified and provided an option to correct this or 

discontinue record addition. 
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Adding a new Installation Job 

 
From the File menu, you can select to add a new installation job to the 

system.  Installations can be customized to be available to every department 

for which you perform and desire to manage installations.  In the demo, only 

the Hood Systems department has installations management available. 
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You will be prompted to find out if the customer for which you are adding 

the installation already exists in the database.  Generally you will want to 

choose ‘Yes’ just to make sure, unless you are positive this installation is not 

for someone that was previously serviced by your company. 
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If you choose to find out if the customer exists, you will be prompted to 

enter part of the customer’s address to locate them.  The address entered 

does not have to be full, and it is best if you only enter a portion of the 

address to make sure someone else didn’t enter the address slightly different 

(i.e. with Rd. at the end instead of Road) 

 

 
 

In this example, we just enter two digits of the address. 
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We are then provided a list of all the customers that have an address 

containing these two digits to select from. 

 

 
 

In this case, we may have wanted to be more specific with the address to 

avoid such a large list of customers. 
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At this point, if the customer is not in the list, we would choose ‘Add 

Installation for New Customer.’  You will go through the same process we 

used to create a customer, with one exception.  The department tab for which 

we added the install will be automatically added to the customer. 
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The installation job information will be displayed first.  You will notice that 

none of the address or general customer information can be added or 

modified from here. 
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The customer card window opened along with the installation card window, 

and we can choose the customer card window at this point if we desire to 

enter the customer’s general information. 
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Once the general information has been entered, the customer card can be 

closed and you can continue working with the installation. 
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Under the configuration options, you will notice a ‘preferred installation 

department’.  Selecting the department for which you personally manage the 

installations gives you the ability to choose ‘Add New Installation’ from the 

file menu to add a new installation for this department.  Currently if the 

default option of ‘None’ is chosen, you will receive a message preventing 

you from adding installations in this manner. 
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In our example, we added a system and gas valve to the installation, and 

choose the status: Install from the dropdown. 
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Clicking ‘Puff Test’ will display a list of puff tests performed in our case, 

and will allow us to manage the status of the puff test and date it is 

scheduled.  Obviously this may not apply to your department, but it’s a good 

example of additional management operations added to a department’s 

installations. 
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This particular puff test has its own custom report called the ‘Puff Test 

Worksheet’. 
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The search form’s specific tabs can be accessed at any time by selecting 

from the Edit menu, or pressing the corresponding F-key for quick access. 

 

 
 

In this case, we want to navigate to the installations search tab so we can 

make sure we can find this newly added installation. 
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By typing ‘Jim’ in the job name field, and pressing ‘List All’, we see our 

installation appear in the list. 
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By selecting ‘Install’ from the Installation Status dropdown, we can list all 

of the current installation jobs that have ‘Install’ status.  As you can see, the 

new record we created is among those listed. 
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Managing Services 

 
By opening the ‘Services Due’ search tab, we can begin our service 

scheduling by entering specific search criteria and generating a list of only 

the services that are currently due meeting our criteria. 

 

 
 

In this case, we searched for services that are due in the month of May, 

during the year 2005, within the Hood Systems department listing only 

customers that are active in our database (ones that we currently service). 
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By right clicking, we have a few options at our disposal.  These options 

include generating a report for all the listed entries, opening the customer 

card for a specific record or opening the service card for a record. 
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By choosing ‘Customer Info List’ we are provided with a report detailing all 

the customers that met our search criteria.  This mechanism provides a 

powerful way to utilize the search forms as a reporting tool. 
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For the purpose of managing the services, we would normally opt to choose 

‘Open Service Card’ once we located a customer with a service due that we 

would like to schedule. 
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We are then presented with the service card for this customer’s due-service.  

By default, the most recent completed service information is added to the 

new service card, to avoid having to re-enter data that is normally very 

similar each service. 
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Once we fill in the Date Scheduled and Time Scheduled, the ‘Add to 

Schedule’ button will become available.  Upon clicking ‘Add to Schedule’ 

you are prompted with a confirmation to add the service to the schedule. 
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All services that have been scheduled will appear highlighted in green on the 

customer cards department tab for which the service was scheduled. 
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Returning to the search card, we now navigate to the ‘Services Scheduled’ 

tab.  This has similar criteria to the Services Due tab, but only lists services 

that are currently scheduled. 

 

 
 

By searching for services scheduled in July 2005, we find the customer for 

which we just scheduled a service in the hood systems department. 



FireSoft Reviewer’s Guide Page 56 of 72 February 12, 2008 

 

© Copyright 2006-08 by FireSoft Solutions, LLC. 
All Rights Reserved. 

We can then right click and choose to report on the services due that are in 

the list, or open the service card for the customer to make changes, or mark 

the service complete.  We will choose to open the service card for the 

customer we just scheduled. 

 

 



FireSoft Reviewer’s Guide Page 57 of 72 February 12, 2008 

 

© Copyright 2006-08 by FireSoft Solutions, LLC. 
All Rights Reserved. 

Once a service has been scheduled, its ‘Date Scheduled’ cannot be changed, 

but the time can be changed at any time.  At this point, a scheduled service 

has to either be marked ‘Complete’ or ‘Incomplete’. 
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When the service is completed, we will choose ‘Mark As Complete’.  We 

will then be prompted to enter the completion date. 
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Returning to the customer card, we notice that the service we just completed 

has our new completion date, and a new service due date has been created 

based on our selection in the ‘Service Frequency’ dropdown. 

 

 
 

If any service due date is incorrect, by right clicking on the service we can 

choose ‘Override Due Date’ to correct the due date. 
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If rather than completing the service on the date it was scheduled, it was not 

completed for some reason; we would choose ‘Mark As Incomplete’ on the 

service card.  This will prompt the user to enter a reason why the job was not 

completed. 
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After entering a reason and choosing OK, the user will be given the option to 

specifically set the next due date or not.  If ‘No’ is chosen, the due date 

defaults back to the previous service due date. 
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By default, incomplete jobs are not shown in the services list in a 

department.  We can choose Options-> Show Incomplete Jobs at any time to 

list these. 
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With ‘Show Incomplete Jobs’ selected, all of the jobs marked incomplete 

will show highlighted in blue on the systems services list in each 

department. 

 

 
 

You can see our recent job marked incomplete defaulted back to its original 

due date because we chose not to specify a due date when marking it 

incomplete. 
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Miscellaneous Management Tools 

 

Letter List: 
There are a few other general management tools within the application, and 

any further management tools can be added per your preference to your 

customized version of the application. 

 

The picture shown below shows us selecting ‘Find Pending Letters’ 
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The ‘Letter List’ will allow us to manage letters sent to customers for any 

reason.  This letter list is integrated with the notes log records, so we are able 

to record when and why a letter was sent to a customer. 

 

Choosing ‘Find Pending Letter’ displays a list of customers that currently 

have unresolved letters pending in the company. 
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By opening the record from the list, the customer card is opened and we see 

in the notes list that a record exists regarding this letter. 
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A notes record can be added to this pending letter list by checking the 

‘Letter Sent’ box within a notes log entry. 
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Department Management: 
If a customer is no longer serviced by a particular department, de-activating 

the customer in that department is very easy. 

 

By opening the customer, and navigating to the department tab that we want 

to deactivate, we simply choose to inactivate the department from the Tasks 

menu. 
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If the customer no longer has any active departments in the company, you 

will receive a message stating that the customer itself is being deactivated. 

 

The customer will no longer show up when searching ‘Active’ customers. 
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As you can see, when a department is de-activated it is shown with unique 

character on the tab, and the department information is not displayed.  Both 

the character and whether or not this information is displayed are definable 

in the configuration. 
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By adding a new department to this customer, the customer becomes active 

again, but the department that was marked inactive does not. 

 

 
 

A department cannot be removed once added; it can only be deactivated.  A 

department can be re-activated following the same procedure used to 

deactivate the department. 
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Conclusion: 

 
Although not everything was covered in this document, this should provide a 

good basis for performing any of the operations within the system.  Adding a 

customer, managing services and adding and managing installations within 

each department is the basis from which most operations in the system work. 

 

This is a living document, and will be updated based on user feedback and 

necessity.  If you have any further questions regarding a feature or features 

that were not covered in this document, or find that the document is lacking 

in explanation of a specific area you believe should be included, please feel 

free to email us anytime at talktous@firesoftsolutions.com. 

mailto:talktous@firesoftsolutions.com

